
Getting Started

Before you begin creating music with Reason 4, you’ll need to install and

register the program. You’ll also need to decide what kind of peripheral gear you’ll want to

use with Reason. In this chapter we’ll cover your options for your Reason studio, includ-

ing your computer and external hardware such as MIDI keyboards, and control surfaces.

We’re also going to cover some basic digital audio information.

Topics include:

■ About Reason

■ What You Need to Create Music with Reason

■ Reason Terminology

■ Installing Reason

■ Setting Reason’s Preferences

■ Reason Support Resources

■ Content for Reason

■ A First Look at Reason
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About Reason
Reason is a completely self-contained virtual recording studio, containing all of the instru-

ments, effects, and sequencing functionality you need to create music in any genre. Reason’s

synthesizers, samplers, and signal processing devices give the user access to an unlimited

supply of sounds and sound-shaping possibilities, as well as endless possible routing

options, all available within the Reason environment.

The first release of Reason, version 1.0, appeared in 2000 and was an immediate hit

with digital audio music producers around the world. Reason’s creators, Propellerhead

Software, were already known for ReCycle, their loop-editing software, and for the

ReBirth RB-338 virtual instrument, which was based on the Roland TB-303 Bass Synthe-

sizer and the Roland TR-808 and TR-909 drum machines (see the sidebar “ReCycle and

ReBirth”).

The idea behind the Reason software was simple and original: an entirely self-contained

“virtual rack” of instruments and effects, mimicking the kinds of setups you might find in

a typical hardware-based recording studio, combined with a virtual sequencer for arrang-

ing and editing complete performances and songs. Not only does the program effectively

replicate an incredible range of hardware devices, but it does so at a fraction of the cost. A

hardware-based studio with all of Reason’s devices would cost much more than the pro-

gram alone, even after factoring in the cost of a computer and a MIDI keyboard to work

with Reason.

Reason version 1 introduced the Redrum Drum Computer, the Dr. Rex Loop Player,

the SubTractor Analog Synthesizer, and the NN-19 Digital Sampler instruments, along

with many audio effects; the Mixer 14:2 mixing console; and the Reason sequencer. Each

successive release of Reason has expanded the program’s functionality while retaining all

of the included instrumentation and effects from previous versions.

In 2002 Reason version 2.0 introduced the Malström Graintable Synthesizer and the

NN-XT Advanced Sampler. In 2003 Reason version 2.5 introduced the Scream 4 Distor-

tion and the RV7000 Advanced Reverb along with the Unison and Spider routing devices

that allow users to combine and split signals from multiple instruments and effects. Rea-

son 3, released in 2005, added the MClass Mastering suite and the Combinator device,

which can be used to combine and save multiple instruments and effects in recallable con-

figurations. Reason 3 also introduced new Browser functionality for accessing, organizing,

and loading samples, loops, and patches for Reason’s devices.

The current version, Reason 4, was released in October 2007 and includes a complete

redesign of the Reason sequencer and the addition of a new instrument, the Thor Polysonic

Synthesizer. Reason 4 also includes two other new devices: the RPG-8 Arpeggiator, for

creating arpeggiated performances with Reason’s instruments, and the ReGroove mixer,

for adding dynamic and rhythmic variations to Reason tracks.
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R E C Y C L E  A N D  R E B I R T H

The ReCycle program “slices” audio loops into sections and then exports them in the REX for-

mat so that they can be played back at varying tempos, edited and altered, or even entirely

rearranged to create new performances. You’ll be learning more about ReCycle and the REX

format in Chapter 3, “The Dr. Rex Loop Player.”

ReBirth was officially discontinued in 2005 but Propellerhead has made the program avail-

able as a free download for both Mac OS 9 and Windows operating systems (Windows 98, NT,

ME, and XP). You can find out more about the ReBirth RB-338 at www.rebirthmuseum.com.

What Reason Can Do

Reason 4 is a complete set of virtual music creation tools. Unlike other DAW (digital

audio workstation) programs that make use of various plug-in formats to use virtual

instruments and effects, every instrument, effect, and routing device used by Reason is

contained within the Reason program and interface. These elements are combined with

Reason’s powerful sequencer, enabling the user to create, edit, arrange, and export entire

songs from start to finish entirely within the Reason program.

Something else that sets Reason apart from other virtual instrument and DAW pro-

grams is the ability to route Reason’s various devices in unique and interesting ways. 

Reason’s instruments and effects can be connected, layered, and used to control and affect

each other in endless and often surprising combinations.

Reason contains its own built-in mixing consoles and multiple ways to record, program,

edit, automate, and sequence performances. Reason also does an excellent job of maximiz-

ing your computer’s resources to allow you to create complicated, complex, intricate pieces

of music.

As any quick look at the Propellerhead Software website will show you, Reason lends

itself particularly well to electronic and dance music genres, and has become the program

of choice for many hip-hop and urban music producers. Reason is also the go-to program

for many people who work with and create loops or compose music for video games, tele-

vision shows, commercials, and movies. Reason’s versatility makes it an invaluable tool in

any digital studio. Working and experimenting with any one of Reason’s instruments can

lead to hours and even days of creative possibilities. Combining any two or more elements

in Reason increases the creative possibilities exponentially.

Another unique feature of Reason is the way that the program lends itself to collabora-

tive use with other DAW software. It’s no coincidence that ReWire, the protocol that allows

Reason to be used in conjunction with other DAW programs, has become an industry

standard and an important piece of functionality of every major DAW program.
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R E W I R E

ReWire is a protocol that allows two DAW programs to communicate with each other. Origi-

nally created by Propellerhead Software and the Steinberg music software company to allow

the ReBirth RB-338 and Cubase programs to work together, ReWire has become a standard

feature of most DAW programs as well as many virtual instruments. By utilizing the ReWire

protocol, you can route an entire stereo mix or individual tracks from Reason to another DAW

program. Many producers take advantage of ReWire to create songs in Reason, and then use

another DAW program for final mixes. The specifics of using ReWire will be covered in detail

in Chapter 10.

What Reason Can’t Do

There are a few things that Reason doesn’t do:

• You can’t record audio directly into the program.

• You can’t use Reason to control external MIDI devices.

• Reason does not support Steinberg’s VST (Virtual Studio Technology), Audio Units,

or any other kind of third-party plug-in effect or plug-in virtual instrument.

However, all of these functions can be found in most other DAW programs (Live, Logic,

ProTools, Digital Performer, etc.), and through the use of ReWire you can combine Reason

with any of these programs and access these kinds of functionality.

Reason Is 100 Percent Digital

Reason is an entirely digital program, meaning that everything that takes place in Reason

happens within your computer or in conjunction with a connected MIDI device that is

sending digital information to the program. However, many elements of Reason are

specifically designed to mimic analog functionality. One example of this is the SubTractor

Analog Synth, which isn’t analog at all but contains functionality, signal-routing, and

sonic abilities that are based on popular analog synthesizers. Another example is Reason’s

audio routing functionality, which uses virtual cables and virtual jacks to connect instru-

ments and effects to each other and to Reason’s mixers.

Buying Reason

You can buy Reason directly from the Propellerhead website at www.propellerheads.se.

The program is also available from your local music retailer and many online music retailers.

Reason can sometimes be found as part of a bundle, with an included MIDI controller or

other incentives. Prices can vary depending on where you purchase Reason, so it’s worth

checking around for the best deal possible.
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If you haven’t yet purchased Reason, you may be considering a local Internet bulletin

board, eBay, or another online auction site. If you are planning to purchase Reason from

one of these resale sources, make sure you are dealing with a reputable seller. More often

than not, a deal that looks too good to be true will turn out to be a copied DVD or pirated

version of the program.

Upgrading from a Previous Version

Reason users who already own any previous version of the program can buy an upgrade

to Reason 4 at a reduced cost. The upgrade is available from the Propellerhead website and

from your local or online music retailer. The upgrade disc contains exactly the same con-

tent as the full-version disc. The Reason 4 upgrade disc does not come with a serial num-

ber, but includes an upgrade code. Once you’ve installed the Reason 4 upgrade, go to the

Propellerhead website and sign in to your account. There you’ll be able to enter the upgrade

code to receive your new serial number by e-mail.

Academic Versions

Academic versions of every release of the Reason program are made available for students

and anyone affiliated with an academic institution. Academic versions of Reason are full-

featured in every way, and registered users have access to the same content on the Pro-

pellerhead website. The difference between the Academic version and the full version is

that users of the Academic version are not eligible for upgrades. For example, if you pur-

chased an Academic version of Reason 3, you are not eligible to buy the discounted

upgrade to Reason 4.

Technically you must prove affiliation with an academic institution to buy Academic

versions of any software, but some sellers will (illegally) overlook this requirement. If you

see a boxed version of Reason offered anywhere at a large discount, you’ll want to make

sure you are not purchasing an Academic version of the software.

Reason Adapted

Along with the full version of Reason, there’s also a “light” version available called Reason

Adapted. Reason Adapted is bundled with ReCycle, all versions of ProTools LE, as well as

many other hardware and software digital audio products.

Reason Adapted is a good way to become familiar with the Reason interface and grasp

how the program works. Different versions will have different levels of functionality, but

generally, Reason Adapted will be limited to a set number of instruments and won’t sup-

port any content other than the included sound bank.

Anyone who has received a copy of Reason Adapted can upgrade to the full version of

Reason at a significant discount. Go to the Propellerhead website and click the PropShop

link at the top of the page, then look for the Reason Adapted Upgrade link. This book

assumes you are working with the full version of Reason.
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The Reason 4 Demo

A demo version of Reason 4 is available on the Propellerheads website. You can download

the Reason 4 demo by clicking the Download link at the top of the page. The demo version

comes with a limited number of sounds and quits after 20 minutes.

Transferring Licenses

If you would like to buy or sell a used copy of Reason, licenses can be transferred from one

owner to the next. This includes access to tech support, applications, free content, upgrade

discounts, and more on the Propellerhead website. To transfer a license both the buyer

and seller must have user accounts at www.propellerheads.se. The seller needs to know the

buyer’s Propellerhead account username. To transfer a license, click the My Account link

at the top of the Propellerhead website home page, click the My Registered Products link,

and follow the instructions to transfer a single license or multiple licenses.

What You Need to Create Music with Reason
To make music with Reason 4, your studio setup could be as simple as a laptop and a set

of headphones or as complex as a dedicated CPU, a hardware audio interface, multiple

MIDI controllers, a hardware mixing board, a digital audio workstation program to

“ReWire” Reason into, and expensive studio monitors. Most Reason users create music 

in studios that fall somewhere in the middle of these two extremes.

Many of the decisions you make regarding your gear will be dependent on a number of

factors. These include the kind of music you’re making, the environment you are working

in, and of course, your budget. The following are some ideas, some mandatory and some

not, for setting up your Reason studio.

Your Computer

Along with the program itself and the included files, you will, of course, need a computer

to create music with Reason. Reason 4 can be run on both the Microsoft Windows and

Mac OS X operating systems. Aside from some minor differences in the File menu (which

we’ll get to later in this chapter), Reason looks and works exactly the same on both operat-

ing systems. The following are the minimum system requirements for using Reason 4.

Windows:

Windows XP SP2 or Vista

Processor: Intel P4/AMD Athlon XP or better

Memory: 512MB of RAM minimum, 1GB recommended

Screen resolution: 1024x768
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2GB of free hard disk space

DVD reader

16-bit Windows-compatible audio card, preferably with DirectX or ASIO drivers

Mac OS:

Mac OS X 10.4

Processor: G4 1GHz and up or Intel Mac

Memory: 512MB of RAM minimum, 1GB recommended

Screen resolution: 1024×768

2GB of free hard disk space

DVD reader

These represent the absolute minimum system requirements needed to run the Reason

program. Having a faster computer with more RAM and more free hard drive space

will mean having much more power and flexibility at your disposal when working with

Reason. While the minimum system requirements for installing and running Reason 4

suggest at least 2GB of free space, both Windows and Mac OS X operating systems will

run better with a minimum of 10GB of unused hard drive space and at least 1GB of

installed RAM.

These benefits will include access to higher numbers of tracks (also known as track

count) and to more of Reason’s instruments effects in your sessions, along with the ability

to use higher-quality sample files to create better-sounding music.

Whenever possible, having a computer specifically dedicated to Reason and/or any

other audio applications is preferable. In many cases, this won’t be possible, but there are

things you can do to keep any computer in optimum shape.

On Windows systems it’s a good idea have antivirus and anti-spyware programs

installed as well as perform regular maintenance routines, such as defragmenting your

hard drive. Windows Vista has a number of system diagnostic and maintenance tools

available in the Control Panel.

On Macs you can keep your computer healthy by regularly using free programs such 

as OnyX (www.titanium.free.fr) or TinkerTool (www.bresink.com) to clean and maintain

your system.

Sound Cards and Audio Interfaces

Sound cards and audio interfaces are used to both record audio into and send audio out of

your computer. All Apple computers come with standard built-in audio functionality that

can be used to work with Reason. Many are capable of recording.

what you need to create music with reason ■ 7

49949c01.qxd  2/25/08  11:03 PM  Page 7



Almost all Windows operating system computers come with a built-in sound card that

can be used for Reason, and many have some recording input capability as well. Since you

won’t be recording directly into Reason, having a separate hardware audio interface is

optional, though the program will certainly work with just about any Mac- or Windows-

compatible audio interface currently available.

If you plan to record your own audio tracks in another DAW program while using 

Reason via ReWire, or you plan on recording original content for Reason (such as creating

original loops or samples to load into Reason’s devices), you could record into your com-

puter’s built-in audio input or included sound card. However, you will almost always be

better off with a separate hardware audio interface, which will offer better audio connections

and sound quality.

Figure 1.1 shows Avid’s popular M-Audio MobilePre USB audio interface.

A hardware audio interface can be as simple and inexpensive as a USB audio device

with one or two inputs, or a more complex FireWire interface with multiple inputs such as

those made by PreSonus (www.presonus.com), M-Audio (www.m-audio.com), or any number

of digital audio hardware manufacturers.

When looking at the many options available, you’ll want to take a few things into

account, such as how many audio inputs and outputs will you need and what sample rates

and bit depths the device capable of using to record and play back audio (see the sidebar

“Sample Rate and Bit Depth”).

You can research more information about digital audio hardware interfaces by 

checking out review sites such as Harmony Central (www.harmony-central.com) or 

audioMIDI (www.audiomidi.com), or digital audio websites such as Tweakheadz Lab

(www.tweakheadz.com).

Many audio magazines have websites with reviews and articles along with forums dedi-

cated to audio recording in general and, often, digital audio in particular. Some of these are:

Sound on Sound, www.soundonsound.co.uk

Electronic Musician, www.emusician.com
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Figure 1.1

The M-Audio

MobilePre USB

audio interface
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Tape Op, www.tapeop.com

Virtual Instruments, www.virtualinstrumentsmag.com

Music Tech, www.musictechmag.co.uk

If you already own and use an audio interface, configuring your already connected

device is covered in the “Setting Reason’s Preferences” section of this chapter.

MIDI Hardware

A MIDI keyboard is essential to getting the most out of Reason. While it’s possible to create

music entirely within the program’s interface, adding a MIDI keyboard to your workflow

will greatly enhance your ability to create music with Reason, even if you have no previous

keyboard experience.

As we’ll see later in this book, built into the Reason program are a great number of

editable parameters, many of which can be controlled externally, thereby adding an

incredible range of possibilities to your creative arsenal.

There are many options for working with various MIDI devices, including hardware

MIDI interfaces, MIDI keyboards, and other kinds of controllers and control surfaces.

W H A T  I S  M I D I ?

MIDI, which stands for Musical Instrument Digital Interface, was first introduced in 1983 as a

way for multiple synthesizers to communicate with each other. As digital and computer audio

has developed, MIDI has been incorporated in some way into just about every digital audio

workstation program available. In Reason’s case MIDI information is used to record and cre-

ate performances, both within the program and by using an external MIDI keyboard or other

controller device. MIDI information can also be used to control many of Reason’s parameters

externally.

In the early days of digital recording, the process of installing and using MIDI devices with

digital audio software could be quite daunting, especially to non-technophiles. MIDI also

came to be associated in many people’s minds with tinny-sounding files used to play audio

on their computers and sterile-sounding performances created with early MIDI technology.

Advances made in recent years have made uses of MIDI technology both user-friendly and

highly flexible.

continued 

Another option, discussed at the end of this section, is to buy a device that combines audio

and MIDI recording functionality.
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W H A T  I S  M I D I ?  (continued)

You can use Reason and its included MIDI functionality extensively with little or no under-

standing of how it actually works. However, the more you know and understand about MIDI,

the more access you’ll have to the functionality of your MIDI keyboard or interface as well as

MIDI functionality within Reason. In Chapter 2’s “Reason and MIDI” section, you’ll learn more

about how Reason uses MIDI.

MIDI Interfaces

Depending on your studio setup you may already have a MIDI interface. If you don’t

already have one, you may or may not need to purchase one in order to use a MIDI device

with Reason. Many of today’s MIDI keyboards and controllers can plug directly into your

computer’s USB ports. In fact, many are even USB-powered. However, if your MIDI key-

board or controller does not have USB connectivity, then you will need to have a MIDI

interface.

MIDI interfaces range from very simple and inexpensive models such as the E-MU

Xmidi 2x2 from E-MU Systems (www.emu.com), shown in Figure 1.2, to more expensive

devices with multiple outputs and other features, such as the ability to synchronize

multiple MIDI devices, digital audio programs, and hardware.

Having a MIDI hardware interface is a good idea if you are planning to use multiple

MIDI devices in your sessions or you need to synchronize Reason with software that’s

running on other computers.

Instructions for installing and configuring specific MIDI hardware interfaces will be

included with the device. If you are using a MIDI hardware interface, make sure that its

drivers are current and up to date by going to the manufacturer’s website.
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Figure 1.2

The E-MU XMIDI 2x2
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K E E P I N G  Y O U R  D R I V E R S  C U R R E N T

Most audio and MIDI devices will require that you install drivers in order for your computer to

communicate with the device correctly.

Your audio interface, MIDI keyboard, or control surface will come with a CD or DVD con-

taining the necessary drivers. It’s very important that you make sure your drivers are the most

up-to-date available for your operating system. It’s possible that minor or major operating

system updates can take place between the time your hardware device is packaged and

shipped and when you buy it. This can make the packaged drivers that come with your hard-

ware obsolete.

You can find specific information about operating system compatibility on the device’s

packaging and also often on a “read me” file contained on the CD or DVD with the device’s

drivers. This will usually include a link for downloading any driver updates.

If you install an update or a new operating system, you may have to download and install

new drivers in order for your audio and MIDI hardware to work correctly.

If you are unsure about the currently installed drivers for your hardware interfaces, go

directly to the manufacturer’s website and download the compatible drivers for your operat-

ing system.

MIDI Controllers

The term MIDI controller can refer to both hardware and software components, but in the

context of this chapter it refers specifically to hardware devices used to transmit MIDI

data to Reason.

M I D I  K E Y B O A R D  C O N T R O L L E R S

A MIDI keyboard will be your single most important external tool for creating music 

with Reason. Your MIDI keyboard can be used to play Reason’s synthesizer and sampler

instruments to create melodies, bass lines, and drum tracks. MIDI notes played on your

MIDI keyboard will be recorded onto tracks in Reason’s sequencer, where they can be

edited, manipulated, and arranged to create individual tracks and entire performances.

Many MIDI keyboards can also be used to control Reason’s playback functionality,

including launch loops and sequences, and even to access some editing and mixing

functionality.

The simplest MIDI keyboards start at around $50 and go up from there. For working

with Reason, it’s a good idea to consider getting at least a mid-price range ($100 to 300)

MIDI keyboard that contains extra functionality such as Pitch Bend and Mod wheels and

other knobs and sliders. This extra functionality can be used in conjunction with various

parameters to control Reason’s functionality remotely.
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Examples of this type of MIDI keyboard include the Novation ReMOTE SL and the 

M-Audio Axiom 49, shown in Figure 1.3.

Many companies manufacture a wide range of MIDI keyboards, including Roland’s

Edirol product line (www.edirol.com), Novation (www.novationmusic.com), M-Audio

(www.m-audio.com), and Korg (www.korg.com).

P h o t o  c o u r t e s y  o f  A v i d  T e c h n o l o g y ,  I n c .

M I D I  C O N T R O L  S U R F A C E S

The term MIDI controller can be used to describe a MIDI keyboard, but there are various

other kinds of MIDI controllers as well. A MIDI controller can also be a hardware set of

sliders, knobs, and/or pads that can be used to mix, trigger samples and loops, or exter-

nally control Reason’s instruments and effects. These kinds of MIDI devices are known as

control surfaces.

Some popular control surfaces for working with Reason include the Evolution UC-33e

(www.m-audio.com), The M-Audio Trigger Finger (www.m-audio.com) (Figure 1.4), the Fron-

tier Tranzport (www.frontierdesign.com), the WaveIdea Bitstream (www.waveidea.com), and

the Novation Remote Zero SL (www.novationmusic.com).

P
H

O
T

O
 C

O
U

R
T

E
SY

 O
F 

A
V

ID
 T

E
C

H
N

O
LO

G
Y

, I
N

C
.

Figure 1.4

The Trigger Finger

control surface

Figure 1.3

The M-Audio Axiom

49 MIDI controller
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All of the resources suggested earlier for researching audio interfaces will be useful in

finding out more about MIDI keyboards and control surfaces as well.

M O R E  O N  M I D I

For specific information about how Reason works with MIDI, see the “Reason and MIDI”

section of Chapter 2.

C O M B I N E D  A U D I O  A N D  M I D I  I N T E R F A C E S

Buying an interface that combines audio and MIDI functionality is a great solution if you are

looking for a way to simplify your digital music studio setup. Most companies that make

audio and MIDI interfaces have products that combine both features in a single unit.

Reason Terminology
The following are some terms and concepts used throughout this book, relating to both

digital audio in general and the Reason program in particular:

Reason Rack The Reason rack is the shell or core of the Reason interface. An empty rack

contains the Reason Hardware Device, used to send audio from the program to your com-

puter’s audio outputs or your attached audio interface; the Reason sequencer, used for

arranging and editing your tracks; and the Transport panel, where you’ll find Reason’s

playback functionality and much more.

Reason Device A Reason device is any of the various components that can be added to the

Reason rack to create songs. This includes all of the program’s instruments and effects as

well the routing, pattern sequencing, and arpeggiator components.

Reason’s Instruments Reason’s instruments are any Reason devices that can create sound.

This includes the program’s synthesizers, samplers, and the Dr. Rex Loop Player. Reason’s

instruments will be covered generally in Chapter 2 and in greater detail in Chapters 3–6.

Reason Effects Reason’s effects are signal-processing components used to alter and

enhance the sounds created by Reason’s instruments. This includes the program’s half-

rack effects, which include reverb, delay, and various other standard audio effects. Reason

also features two effects capable of loading and saving patches: the RV7000 Advanced

Reverb and the Scream 4 Sound Destruction Unit. The MClass Mastering effects were

added in Reason 2.5 to give Reason users better options for mastering their final mixes.

Reason’s effects are discussed in general in Chapter 2 and covered in detail in Chapter 7.

The Reason Sequencer A sequencer is a hardware or software device that is used to

“sequence,” or arrange, a performance or multiple performances. In digital audio, a

sequencer can refer to a digital audio workstation program, or as in Reason’s case, a 

reason terminology ■ 13

49949c01.qxd  2/25/08  11:03 PM  Page 13



component within such a program. The sequencer is found in the bottom part of the 

Reason rack and can be used to create and edit performances as well as arrange them.

ReFills ReFills are Propellerhead’s compressed format for organizing and distributing

content for Reason’s devices. Reason comes with two ReFills: the Reason Factory Sound

Bank, which contains content for all of Reason’s devices, and the Orkester ReFill, which

contains content specifically for Reason’s samplers. You’ll find more information about

ReFills, including resources for finding commercial, free, and demo content from Pro-

pellerhead and many third-party sources, later in this chapter.

Patches Patch files contain specific information that is used to save and recall settings on

Reason’s instruments and effects. This information tells the device which settings to use

and, if appropriate, which samples to load and where they are located. You can create your

own patch files either from scratch or by altering existing patches such as those found on

the Reason Factory Sound Bank.

REX Files REX files are loops in the .rx2 format, created in the ReCycle program. REX files

are generally used with the Dr. Rex Player but can also be used in Reason’s sampler

devices.

Automation Automation is the ability to record the movement of Reason’s knobs, but-

tons, sliders, and faders. Reason allows automation of many available features, including

many obscure or unexpected parameters.

Installing Reason
Installation of the Reason program is fairly simple. Unlike previous versions of Reason,

which came on multiple CDs, Reason 4 comes on a single DVD containing the Reason

program itself along with the Reason Factory Sound Bank and the Orkester Sound Bank

ReFills.

Installation Instructions

Follow these instructions to install Reason on your computer. If you have a previous ver-

sion of Reason installed, you’ll need to delete the program first. On a Mac you can just

drag the Reason folder to the Trash. On Windows you’ll need to run the uninstaller

located in your Reason folder:

1. Insert the Reason DVD into your computer DVD reader.

2. On a Mac, copy the Reason folder to your Applications folder. On Windows double-

click the Install Reason icon.

If you are upgrading from a previous version of Reason, you should uninstall or delete the

existing version before installing Reason 4.
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Figure 1.5

The Reason 

Setup Wizard

3. Locate the Reason program icon on your hard drive or Start menu and double-click it

to start the program.

4. Click the Agree button to agree to the terms and conditions of the Licensing Agreement.

5 If necessary, reinsert the Reason 4 DVD in to your DVD reader. Reason will 

copy the Reason Factory Sound Bank 

and Orkester ReFills to your Reason 

folder.

6. Enter your username, organization,

and license number in the Enter License 

Number dialog.

7. Click OK.

Once you’ve finished the installation 

process, the Reason Setup Wizard will appear 

(Figure 1.5).
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You can use the setup wizard to quickly go through the process of choosing your audio

output preferences and setting up your Master Keyboard (the MIDI device you’ll use to

play Reason’s instruments). If you know which audio output you want to use and if you

are able to assign your connected MIDI keyboard as your Master Keyboard, then the setup

wizard may do everything you need to get Reason configured and ready to use.

For more advanced setup options, click the Open Preferences Dialog button at any

time during the setup wizard process, or cancel the Wizard and open Reason’s Preferences

from the menu bar. On Windows choose File ➔ Preferences; on Mac OS X choose Reason ➔

Preferences.

For further instructions and details about Reason’s Preferences, see the next section,

“Setting Reason’s Preferences.”

Once you’ve finished or cancelled the setup wizard, if you have an active Internet con-

nection you can click the Register Now button to go to www.propellerheads.se and register

your copy of Reason 4. You can also register at any time by choosing Contacts ➔ Register

Reason Now.

R E G I S T E R I N G  R E A S O N

Creating an account at www.propellerheads.se and registering Reason 4 will give you access

to free ReFills containing lots of great sounds, to Propellerheads Reason forums, to tech sup-

port, and to free utilities such as ReLoad (for creating ReFills from AKAI format sample discs)

and the ReFill Packer (for creating your own ReFills).

Registering Reason also means that if you decide to sell the program you can transfer the

license quickly and easily. You’ll also be able to order a replacement disc for your Reason 4

DVD for a small fee should it get lost, stolen, or damaged.

49949c01.qxd  2/25/08  11:03 PM  Page 15



Setting Reason’s Preferences
If you’ve already cancelled or gone through the setup wizard and want to change any of

your Reason settings, you can do so at any time by accessing Reason’s Preferences. Again,

on Windows you do this by selecting File ➔ Preferences; on Mac OS X you can get to

Reason’s Preferences by choosing Reason ➔ Preferences.

O N E - M I N U T E  P R E F E R E N C E S

Even if you cancelled the setup wizard, you can still go through the process of setting up Rea-

son’s preferences very quickly. Once you know for sure that all of your MIDI and audio con-

nections are in place, follow these instructions for a fast setup of the Reason program and

your MIDI devices:

1. Open Reason’s Preferences from the Edit menu (Windows) or the Reason menu (Mac).

2. Select Audio Preferences from the Preferences drop-down menu at the top of the 

window and choose your preferred audio output device from the Audio Output drop-

down menu.

3. Select Keyboards and Control Surfaces and click the Auto-Detect Surfaces button.

4. If your MIDI device or devices appear on the Attached Surfaces list, you may see a pop-

up window with specific instructions pertaining to your devices. Follow any instructions

as necessary and click OK.

If your connected MIDI device or devices do not appear, see the “Keyboards and Control

Surfaces” section later in this chapter for further instructions.

5. If you only have one MIDI device connected, Reason will make this your Master Key-

board. If you have more than one MIDI device connected, select the device you intend

to use as your main MIDI keyboard in the Attached Surfaces list and click the Make Mas-

ter Keyboard button.

6. Close Reason’s Preferences.

General Preferences

When you open Reason’s Preferences, the first window, shown in Figure 1.6, will display

Reason’s General Preferences.

You can choose between Reason’s four different 

preference windows—General, Audio, Keyboards

and Control Surfaces, and Advanced—by clicking

the drop-down menu at the top of the Preferences

window.
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Mouse Knob Range This setting controls how much precision you’ll have when adjusting

Reason’s parameter knobs and sliders. The Normal setting allows you to adjust most 

of Reason’s parameters in increments of 2. If you find that you need access to more precise

settings, you can open Reason’s Preferences and change this setting at any time. The dif-

ference between Precise and Very Precise will not be apparent on most parameter knobs.

Automation Cleanup The Automation Cleanup setting determines how Reason works

with and displays track and device automation. We’ll come back to this setting in the

“Advanced Automation” section of Chapter 10.

Cable Animation Reason displays the routing between its virtual instruments using the

visual metaphor of a physical device’s back panel, with cables and input plugs. To view

and work with Reason’s routing, press the Tab key on your computer’s keyboard. With

Cable Animation selected the cables will move slightly when first viewed or when later

moved or re-routed. Disabling Cable Animation saves a miniscule amount of processor

resources and is entirely a matter of personal preference.

Show Parameter Value Tool Tip With this setting selected, every time 

you move your mouse over any knob, display, button, or adjustable

parameter, a tool tip displays information, including the object’s

name and the parameter’s current numeric value, if applicable.

Figure 1.6

Reason’s General

Preferences
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Show Automation Indication With this box selected, whenever a knob, slider, or other

Reason parameter is automated you’ll see a green outline around the parameter.

Default Song The Default Song setting determines which song will be loaded whenever

you start the Reason program or create a new Reason song.

Empty Rack This setting will create an empty Reason rack when you create a 

new song.

Built-in This setting will automatically load the default Reason demo song when you

start the program. Each new session you create will use the included mixer and Mas-

tering template, covered in Chapter 2.

Custom This setting lets you specify a template song, either from the included tem-

plates or your own custom-made template.

Leave this selection as Built-in for now. Later in this chapter we’ll look at the default demo

song along with Reason’s other included demo songs. In Chapter 2 you’ll select a tem-

plate song for working with the exercises in this book.

Audio Preferences

Once you’ve set General Preferences, select Reason’s Audio Preferences, shown in 

Figure 1.7.

Figure 1.7

Reason’s Audio 

Preferences
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Master Tuning With this slider you can adjust the overall tuning for your all of your Reason

songs up or down as much as one semitone. This would be useful if, for example, you

wanted to emulate the tuning of baroque instruments, where A = 435 Hz.

Audio Output Select your preferred playback device 

from the Audio Output menu.

Windows users may have any of the following

options to choose from: ASIO, DirectX, or MME

drivers. If your sound card or hardware audio

interface uses ASIO drivers, then this should be your first choice, since ASIO drivers will

give you the best available performance. If ASIO is not an option, choose DirectX. You

should select MME only if it is your only available option. MME drivers are part of the

Windows operating system and should be used only as a last resort.

Mac users can choose either Built-in Audio or any connected hardware audio interface

that appears on the list.

Sample Rate The Sample Rate setting can be used to choose between different available

sample rates. Which options are visible depends entirely on your chosen audio output

device. If your device supports higher sample rates, you can choose one from the list. If

you are unsure of which sample rate to choose, select 44,100. For more information on

sample rates, see the “Sample Rate and Bit Depth” sidebar in this section.

Buffer Size The Buffer Size setting determines the amount of latency you’ll experience

when working with Reason and your selected audio output device. Latency is the differ-

ence in time between when you play a key on your MIDI keyboard to trigger a Reason

instrument and when you hear it through your speakers or headphones. The buffer size

will be set automatically, but you can raise or lower it with the Buffer Size slider.

If you are hearing a significant delay, you can try lowering the buffer size. If you are expe-

riencing glitches and dropouts when playing back or recording into Reason, you can try

raising the buffer size. Unless you are experiencing noticeable delays or other problems in

your Reason audio, this setting should be left alone. Sometimes your latency settings will

involve a bit of a trade-off. You may have to put up with a bit of latency to get the most

consistent audio playback.

Output Latency This shows you the amount of latency time in milliseconds. Reason sets

this automatically in relation to the buffer size.

Latency Compensation This setting compensates for latency and is automatically set to

match the output latency time. Latency Compensation can be adjusted manually by using

the up and down arrows if you are attempting to synchronize Reason with a master pro-

gram that doesn’t support ReWire. Otherwise, it’s best left at its default setting to match

the output latency settings.
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Figure 1.8

The Select Active Channels dialog

Active Channels If your audio output device supports

multiple outputs, the Channels button for this setting

will be activated. Click the Channels button to open a

dialog (Figure 1.8) that will allow you to specify which

outputs are active for your audio output device.

You can take advantage of this option if you are plan-

ning to route Reason’s output to an external hardware

mixer.

S A M P L E  R A T E  A N D  B I T  D E P T H

Two terms that you’ll see a lot a lot in this book and in just about anything you read related to

digital audio are sample rate and bit depth. These terms refer specifically to two elements that

determine the quality of digitally recorded and digitally created sound.

To simplify a complicated subject, in digital audio sample rate refers to the number of times

an analog audio signal is “sampled” or captured in one second by the analog-to-digital con-

verter. The standard sample rate for CDs and many digital audio applications is 44,100 kHz. This

means that every second of audio contains 44,100 individual samples. If you cut that in half to

22,050 kHz, you’ll have half the number of samples, and therefore a less accurate representa-

tion of a recorded signal or a lower-quality digitally created sound. Most high-quality DAW pro-

grams currently available are capable of recording and creating audio at up to 96,000 kHz. As

the technology improves, even higher sample rates are becoming more common.

Bit depth refers to the dynamic range of sound that is actually recorded. Sounds recorded

or created at higher bit rates contain a greater range of high and low frequencies. Currently

the most commonly used bit depth for digital audio recording is 24 bits, though lower and

higher bit rates can be used. Eventually most audio is exported or converted to 16 bits for CD

duplication.

As you’ll see in the Sample Rate section of Reason’s Audio Preferences, the sample rate 

and bit depths you can use with Reason depends on your computer’s built-in audio system 

or your sound card or audio interface. Available sample rates vary from system to system, the

most common being 44,100 kHz, 48,000 kHz, and 96,000 kHz.

You’ll work with these concepts when setting up Reason’s preferences, working with

Reason’s samplers, and exporting loops and entire songs. Outside of Reason you’ll see these

terms used when working with other DAW programs, “ripping” audio from CDs, creating MP3

and AAC files, and elsewhere. If you are unsure of which settings to use in any given exporting

situation, the most common bit depth and sample rate settings are 16/44,100.
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Keyboards and Control Surfaces

The Keyboards and Control Surfaces preferences window is shown in Figure 1.9.
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If you have a MIDI device or multiple MIDI devices that you want to use with Reason,

make sure they are connected and powered on; then click the Auto-Detect Surfaces button.

Reason will then scan your computer looking for any attached MIDI devices that it recog-

nizes. Reason has built-in settings for many, though not all, popular MIDI devices, includ-

ing both keyboards and other controller devices.

To set up a single MIDI keyboard or control surface, follow these instructions:

1. Make sure your MIDI keyboard is attached and powered on and that all of the devices

drivers are installed and current.

2. Click the Auto-Detect Surfaces button. If Reason recognizes your device, it appears in

the Attached Surfaces window.

3. Follow any specific instructions that appear relating to your specific MIDI device.

4. Make sure that the Use With Reason box is checked and that

the device is recognized as your Master Keyboard.

5. Select Standard under Master Keyboard Input to make your

keyboard available as the default input device for any selected

track.

In Step 2, if Reason does not recognize your MIDI keyboard or

control surface, you’ll see the message “No keyboards or control

surfaces were auto-detected.” You can add your MIDI keyboard

manually by following these steps:

1. Click the Add button.

2. Choose your manufacturer and model from the drop-down

menus. If either your manufacturer or model does not appear,

select <OTHER> for either category.

3. For some keyboards and control surfaces, Reason will have 

specific instructions that will need to be followed in order to 

use your device with Reason. These instructions will be clearly

visible in the Add Surface window (Figure 1.10).
Figure 1.9

Reason’s Keyboards and Control Surfaces 

preferences
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4. Select the correct MIDI input from the MIDI Input drop-down menu. You can also

set this up automatically by clicking the Find button and pressing any key on your

connected MIDI device.

Adding Multiple MIDI Devices

Depending on whether Reason automatically recognizes one or more of your devices, you

can follow either or both of the previous tutorials to set up multiple devices.

Once your multiple devices have been added to the Attached Surfaces list, you’ll want

to specify a specific device as the Master Keyboard. You do this by selecting the device in

the Attached Surfaces list and clicking the Make Master Keyboard button (Figure 1.11).

Once you’ve set up Reason to work with a specific MIDI device or control surface, you’ll want

to make sure it’s always plugged in and powered on before you start Reason. If not, you’ll

see an error message letting you know that Reason was unable to properly set up Control

Surfaces.

Figure 1.11

Select one of the

multiple devices to

use as the Master

Keyboard.

Figure 1.10

The M-Audio

Radium 61 is one of

the devices that

require specific

instructions for use

with Reason.
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Advanced Control

Reason’s Advanced Control preferences

(Figure 1.12) can be used to configure mul-

tiple MIDI devices to control Reason.

To make a MIDI input available for

Advanced Control, select it from the Bus A,

B, C, or D drop-down menus. This option

will be covered in more detail in Chapter 10.

MIDI Clock Sync

Some uses for MIDI Clock include synchro-

nizing Reason with other programs or with

other instances of Reason running on differ-

ent computers. Reason can only work as a

MIDI Clock Slave, meaning it can receive

but not send MIDI Clock information.

Choose your Master MIDI input from the

MIDI Clock Sync list.

Reason Support Resources
Reason comes with extensive documentation, including an operation manual and a “Get-

ting Started Guide,” both in PDF format. They can be found in the Reason\Documentation\

English folder.

Propellerhead’s website, www.propellerheads.se, has an online support database where

you can find solutions to frequently encountered problems and the answers to frequently

asked questions. You access the online support database by clicking the Support link at the

top of the Propellerheads home page.

If you are unable to find the answers you’re looking for in the support database, you

can e-mail Propellerheads Tech Support by choosing Reason from the Support e-mail

addresses drop-down menu at the bottom of the Support page.

Chapter 2 contains specific settings for Reason’s preferences that you’ll need to change for

working with the exercises in this book.
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Figure 1.12

Reason’s Advanced

Control preferences
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Content for Reason
ReFills are collections of files in a compressed self-contained format. The ReFill (.rfl) for-

mat is similar to a .zip file, except that it doesn’t need to be opened in order to gain access

to the included content. Most Reason content is found in ReFills, though all of Reason’s

instrument and effect patches can exist outside of the ReFill format.

Vast numbers of ReFills are available, containing synthesizer patches, drum kits for 

the Redrum Drum Computer, loops for the Dr. Rex Loop Player, and every imaginable

instrument for Reason’s Samplers.

Some of the highest-quality ReFills are made and sold by Propellerhead themselves,

including Reason Drum Kits 2.0, Essential Pianos, and the Abbey Road Keyboards collec-

tion. Registered Reason users also have access to many high-quality free and demo ReFills

directly from www.propellerheads.se.

Aside from the Propellerhead website, many commercial, demo, and free ReFills are

available from many sources, including your local or online music instrument and soft-

ware retailer. A few of the many companies that create content for Reason are:

www.loopmasters.com

www.sonicreality.com

www.lapjockey.com

Some ReFills will focus on a specific Reason instrument such as a Reason synth or sam-

pler. Other ReFills might contain patches and files for multiple Reason devices, including

synth patches, sample patches, individual samples, REX files, and patches for Reason’s

Advanced Effects. ReFills can also contain MIDI files and complete Reason song files,

which are sometimes included to provide examples of possible uses for a ReFill’s included

patches and files.

File Formats

Each Reason device that is capable of loading and playing patches has its own unique file

format. Each file format is represented by its own icon and file extension. Figure 1.13

shows the icon and file extensions for Reason’s synthesizer instruments.

Figure 1.13

Reason’s synthesizer

patch formats

Refills are by far the most common format for Reason content, but all of Reason’s patch for-

mats can exist outside of the ReFill format.
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Reason’s sampler instruments, which include the Redrum Drum Computer covered 

in Chapter 3 and the NN-19 Digital Sampler and NN-XT Advanced Sampler covered in

Chapter 6, can also load and play back individual samples and loops in the AIFF, Wave,

and SoundFont formats. The individual slices that make up REX files can also be used as

individual samples with Reason’s sampler devices.

More information about content for specific devices can be found in the chapters per-

taining to those devices throughout this book.

Saving and Exporting Songs

Reason is capable of exporting finished songs or sections of songs in both the AIFF and

Wave formats. Simply choose File ➔ Export Song As Audio File or File ➔ Export Loop As

Audio File.

Reason songs can also be saved as either Reason Song Files (.rns) or Reason Published

Song Files (.rps).

The Reason Song File format is for works in progress and can be opened and edited at

any time. You can save your current session as an .rps file at any time by choosing File ➔

Save or File ➔ Save As.

The Reason Published Song format is for sharing finished songs with other Reason

users. This option can be are accessed by choosing File ➔ Publish Song.

Both of these options will be covered in more detail in Chapters 2 and 10.

B A C K I N G  U P  R E A S O N  F I L E S

Having a way to back up your work is important in any digital audio recording studio. The

best method is to have a second external hard drive to copy all of your Reason related files to.

This should include your ReFills and samples as well as your Reason song files, both finished

and in progress.

If you don’t have an external hard drive, another option would be to regularly back up

your work by burning CDs or DVDs.

A First Look at Reason
At this point, you’re probably eager to get started using Reason, so in the last section of

this chapter we’ll do just that. Locate the Reason program on your hard drive or use the

desktop shortcut or Dock icon to launch the program. If you’ve left this Preference setting

alone, by default Reason will start by loading the demo song. If you already have Reason

open, quit the program and relaunch it to see the default Reason song.

Figure 1.14 shows Reason demo song.
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The scroll bars on the left side of the rack and at the bottom of the sequencer can be

used to view any currently unseen elements of the current Reason song.

Reason’s default demo song makes use of much of the program’s functionality, includ-

ing various instruments, effects, and devices. At the top of the Reason rack you’ll see the

Reason Hardware Device, where the output of the Reason program is sent to your com-

puter’s audio output.

Directly under the Hardware Device is the Mastering Combi, a Combinator patch with

presets for mastering your Reason songs. Below the Mastering Combi is the song’s Mixer

14:2, a mixing board device that you’ll find in just about every Reason session. Below the

Mixer 14:2 you’ll see the instruments, effects, and other Reason devices that make up this

Reason song.

If your computer is experiencing problems such as glitches or audio dropouts when playing

back the default song, that probably means your system doesn’t have enough processing

power for complex Reason songs. You can still learn and use the Reason program, but you’ll

need to upgrade your computer and/or install more RAM to get the most out Reason.

Figure 1.14

The Reason default

demo song
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You can collapse and expand the individual interface for any of Reason’s devices using

the show/hide button on the left side of each device.

Finally, at the bottom of the rack you’ll find the Reason sequencer, where the MIDI

performances that trigger and control Reason’s devices are arranged, along with any

automation the song contains. At the very bottom of the rack is the Transport panel with

Reason’s stop, start, and other playback buttons, along with other functionality related to

recording and sequencing Reason songs. All of these features will be covered in Chapter 2

and expanded on in detail throughout this book.

Other Demo Songs

Along with the default demo song, Reason comes with a folder of demo songs. These will

be located in your Reason folder, the same folder that contains the Reason program. Rea-

son’s demo songs are great way to see some of the things that are possible with Reason.

Locate the folder Reason\Demo Songs on your hard drive and double-click any song to

open it. When you open any of the demo songs, you’ll see a splash screen containing an

image. Click the Show Info button to see the song’s details or click OK to go directly to

the song.

These songs are all in the Reason Published Song format (.rps). You can experiment

with these songs by adjusting parameters and moving various elements around, but the

RPS format will not allow you to save any changes you make or export the audio.

Summary
The purpose of this introductory chapter has been to give you a clear idea of what you 

can use Reason 4 to do and how to make the program work for your specific workflow.

After a brief history of Propellerhead Software, You learned about some of the hard-

ware audio devices Reason can be used with. In particular, you learned the importance 

of having an external MIDI keyboard to create performances with Reason’s instruments

and the option of using multiple MIDI devices to control various aspects of the Reason

program. This was followed by definitions of important, frequently used digital audio 

and Reason 4 terminology, which you’ll be seeing throughout this book. With this infor-

mation you’re now able to make decisions about what kind of setup best suits your needs.

Next you learned how to quickly install and configure Reason, with an in-depth

description of all of Reason’s Preferences that you can refer to later as you become more

familiar with the program’s more complex functionality and options. You then learned

about content for Reason’s device, including individual patches and the ReFill format, as

well as some sources of that content, including the Propellerhead website third-party con-

tent providers. All of this knowledge will be useful to you as you progress through this

book, as well as later on when you explore more advanced uses of Reason.
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Finally, you got your hands on the Reason program itself by loading and playing some

of the demo songs that are included with the program. After reading this chapter you now

have a solid foundation and clear ideas about the tools and concepts you need to begin

creating music with Reason 4.
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